Final Cut Pro System Notes

Spring & Fall 2004

I. General Edit Suite information

1. The Edit Suite Policies 

· Students officially registered in appropriate Communication Studies video production courses qualify for swipe-card access to the edit suite. 

· Each production team will be assigned an edit station, an account on that station and a password.  Use only your team’s account and password in completing your project for class.

· Personal production projects are not allowed on the Communication Studies edit systems.  Use of the edit systems for other than officially sanctioned work may lead to revocation of all production privileges. 

· NEVER leave the edit suite door open.  Keep the door closed at all times to avoid security breaches.

· Upon leaving the edit suite, check to be sure the door has closed and latched.

· The edit suite is intended for the serious work of registered Communication Studies students, friends and acquaintances are not allowed unless they are directly involved with the project in post production.

· NO food or drink may be kept anywhere near the equipment.  All such materials must be stored on the round tables in the center of the room.

· Problems involving the edit suite should be communicated as soon as is reasonably possible to Dr. Bill Bolduc (962-7012; bolducw@uncw.edu) or Tony Creech (962-7369; creecht@uncw.edu).

· Make editing reservations using the UNCW Outlook web server. (See below, at bottom of document)

2. The Edit Systems in Bear 170
· There are 3 Final Cut Pro systems in the Communication Studies edit suites.  All systems use the same software, Final Cut Pro 4. The systems are referred to as FCP1, FCP2 and FCP3. 

· FCP 1 is located closest to the door

· FCP 2 is in the middle of the room

· FCP 3 is farthest from the door

· All three systems have an internal system disk and an internal media hard drive.  Story all media on the internal media storage drive. 

· Each project will be assigned a system (FCP 1, 2, or 3)

· A miniDV VCR is connected through a “Firewire” cable, also referred to as IEEE 1394 (NOT the same as a USB connector). 

3. Initial Operating Procedures

A. Systems should be left on at all times.  Do not turn systems off when finished.  Simply log-out.

B. Should you need to power up the system

· It is important to turn on all peripherals before booting-up the Mac and activating the FCP software.

· Turn on all power supplies (UPS  and standard power strips)

· Turn on all peripherals – speakers, monitors, VCRs and the external Hard Drive.
· Turn on Macintosh using button on the FCP keyboard (top right corner).

· Log in to the Mac by clicking on the appropriate icon then entering your team’s password in the space provided. The Mac should ‘boot-up’ immediately and your desktop will appear within a few seconds. 

· IF YOUR ACCOUNT DOES NOT OPEN IMMEDIATELY, wait at least a minute or two.  If your account still doesn’t open and appear on the desktop, press the ‘reset’ button on the front of the CPU.

· Check to see if the external hard drive (XHD) icons have appeared on the desktop.  If not, check to see if they have power or are not connected properly. 

B. Open Final Cut Pro (FCP)

· If you see an FCP icon on the desktop, double click it.

· If you do not see an FCP icon on desktop, move the mouse to the DOCK, which is located either on the right edge or the bottom edge of the right-hand screen.  Click on the FCP icon to open it.

· If FCP says that there is no external input device (e.g., the video deck), check to make sure the VCR is turned on and that the Firewire cable is properly connected.  

C. Quitting Final Cut Pro
· When you are ready to quit FCP

· Save your project by selecting the SAVE ALL option in the FILE menu.

· Quit Final Cut Pro with your project open.  This way, your project will automatically open when you open FCP the next time. 

II. Final Cut Pro Operating Notes

1. FCP Primary work windows

a. Viewer – work with and manipulate single clips.

· Includes Video, Audio, Filters and Motion tabs – each tab allows adjustment of specific elements of the clip

· Clips may be manipulated in hundreds of different ways…size, motion, opacity, color, blur… 

b. Canvas – displays entire sequence, can be used to execute edits. Serves as the Program Monitor in displaying the entire video from the timeline (rather than individual clips).

· Clips can be dragged from Viewer into the Canvas as a means of getting the clips into the Timeline

c. Timeline – where your Sequence is created.  The Sequence is the actual edited program…all audio and video clips connected from beginning to end. 

· Includes time indicators, video and audio tracks, time code and other useful tools (99 audio and video tracks)

· Many/most programs have several sequences. It is often convenient to do different parts of the program as separate sequences, then to bring them all together at the end into one final sequence. (e.g., intro sequence, 1st sub-story, 2nd sub story, and final summary sequences all created separately, then pulled together to create the final program.)

· The Timeline may be viewed in various levels of Zoom.  That is, you can zoom in to a very close view to facilitate very fine edits (e.g., adding one frame to a transition) or at a very wide view to get a look at the entire sequence. 

· To zoom in, press the Z key once.  To zoom out, press the Z key twice.

d. Browser – a virtual “file-cabinet,” the Browser is where your clips and sequences are stored and where you gain access to Effects
· Project Tab: holds Bins which hold individual Clips and Sequences for your project.  Here is where you organize your Bins, Clips and Sequences.

· Effects tab: contains a long list of effects that can be applied to your video including  – audio and video transitions and filters, and video generators

· Transitions bin holds transitions – cross dissolve, page turn, wipes, fades, 3-D transitions, irises, slides…

· Video Filters bin holds filters to be applied to video clips – blur, color correction, distortion, keys, borders…

· Audio Filters bin – 3-band equalizer, sound correction, de-essers, hum remover, echo effects, etc…

· Video Generator bin contains specialized video content (other than clips) – text (several variations), bars and tone, color mattes (for solid color backgrounds)

· Favorites bin – a bin in which you can store favorite effects, filters and transitions that you use often.  Typically your favorite transitions and titles would be stored in here.  You can also customize certain effects and save them in the Favorites bin (for example, save a 10 frame dissolve in the Favorites bin if you use it often).

2. Mini-windows: 

a. Tools – a small window of work tools may be displayed on the screen.  Includes: razor, pen nib, slip edit, roll edit and track selection tools

b. Audio meter – an LED audio meter, lets you see the audio input level

3. Organization and storage of clips within Final Cut Pro

a. Browser Window

· The Browser Window is essentially the ‘file cabinet’ where all of your clips are kept within Final Cut Pro.  Within the Browser, you will create a series of bins where various categories of clips are stored.  

b. Bins    

· Once FCP has opened, you will need to organize your files in folders, or bins.  Create bins in your project file where your video and audio clips will be stored.  The bins are located in the Browser window.   You may wish to create general categories then add “subfolders” or “sub bins” within them.  

· In reality, the clips indicated in your FCP bins are simply linking files to the Quicktime movie file stored on the HD (in the Capture Scratch folder).  When you click on a clip in FCP, the software retrieves the actual media clip from the HD and displays it in FCP.

· Before you begin to capture media, develop an organization and storage scheme for your clips. 

	You may organize clips by:

· Tape number


· Topic, subject matter

· Where the clips belongs in the final program

· Or a combination of methods

Example:




Browser for Project Sunset





Bin 1: Interviews






Sub bin a: Mr. Smith 






Sub bin a: Mr. Jones





Bin 2: Aerial shots





Bin 3: Beach shots





Bin 4: Person on street interviews





Bin 5: Sunset/sunrise





Etc…  




c. Naming clips

· It is very important to have a scheme for naming the clips prior to beginning the capture process. When naming clips, find a way to make sure each clip name may be easily distinguished from all other clips.  Provide some detail to make sure that when you are editing this project over weeks or months, that you can easily identify the clips.

· What not to do: Interview 1, Interview 2, Interview 3, b-roll 1, b-roll 2, etc… Using such a naming scheme will make it very difficult to distinguish between them since you may have up to 60 or more shots in each of those categories. 

· Instead: Smith – why I do it, Smith – how group is organized, Jones – reasons, Aerial – MnkyJnction, Aerial – old Walmart, Sunrise – bluish ***, Beach – girl red suit, Beach – kids play 1, Red dog walks, 2 dogs play in water, flags on cars, Bozeman sign, etc…

· Look for shortcuts that will summarize the content of the video.  Add indicators or symbols to remind you of the really great shots.  $ = money shot, *** = great shot

3. Log and Capture window – this window enables you to capture video clips from your tape (we will assume DV tape for this example).  The Log and Capture window contains the following elements:

a. Viewing screen – lets you see the clips you are viewing and capturing

b. VTR controls – if you are using a deck connected through Firewire, you can control that deck (or DV camcorder) with the computer (that is, you don’t have to physically fast-forward, rewind or play the deck, the computer will allow you to control the deck automatically).  This is called “device control” and won’t work with a regular VHS or SVHS tape. 

· Play

· Rewind/Fast Forward  - fast tape movement during which you CANNOT see the image on the tape (good for moving back or ahead over three to five minutes)

· Shuttle/Search control – fast tape movement (forward or backward) during which you CAN see the image (fine for moving ahead a couple of seconds to a few minutes)

· Jog dial – allows frame-by-frame movement of the tape

c. Edit controls

· Mark In – marks the beginning of the clip you wish to capture

· Mark Out – marks the end of the clip you wish to capture

d. Logging Tab 

· Log Clip button – once an In and Out point have been Marked, you must Log the clip – give it a name.  The computer will automatically store the In and Out points on the tape.  In addition to naming the clip, you may include notes and other information about the clip.

· Once a clip has been logged into FCP, a clip icon appears in the Logging Bin  with a red line through it.  The red line indicates that the clip has been logged but not yet captured.  When the clip is captured, the red line disappears.

· Logging Bin.   Before logging a single clip you must set your Logging Bin, that is, identify to the computer.  

· The Logging Bin is the bin in which the clips from “this” tape will be stored.  To set the Logging Bin:

·  Before selecting a logging bin, you must create logging bins for your clips.  

· Open Log and Capture window

· To create a bin:  Open your project then open the following menus:  File, New.  Then click on Bin.  This will create a new bin.  Name the bin by typing a name in the name window.

· Example: you are about to log clips from the chancellor’s press conference videotape.  

· 1) Go the the project tab in the Browser window.  

· 2) Create a new bin called “Chancellor Press Conference”. 

· 3) Highlight the bin.  

· 4)  Go to the File menu. 

· 5) Select “Set Logging Bin.”  Now, when you start logging and capturing your tape, the clip links will be stored in the Chancellor Press Conference bin.

· I recommend creating all of your bins before capturing and editing.

· In your Browser window, “highlight” the bin (folder) where you want to save the clips you are about to capture - (click on the bin to highlight it).

· In the FCP main menu, click on the File menu.

· Click on the “Set Logging Bin” command in the File menu.

· This will set the selected bin as the bin where your clips will be stored.

· Capture buttons

· Batch – once several (2 or more) clips have been logged, hitting the Batch capture button will allow you to capture them as a group (several at one time rather than one at a time). 
· Log several clips into your Logging Bin

· Play tape using controls in the Log and Capture window

· Hit “I” to set the in point, hit “O” to set the out point

· Hit the “Log Clip” button to open the logging dialog box (F2 = Log Clip)

· Enter information and hit OK to log the clip

· The clip name and a clip symbol with a red line through it will appear in the logging bin

· Play tape and continue logging clips until you wish to capture

· In the Log and Capture Bin, select the “Batch Capture” option

· This will open a dialog box and you will need to choose among several options that might be provided

· Capture All Clips in Logging Bin – will capture all clips in the bin

· Capture Selected Clips in Logging Bin – will capture only those clips you have selected.  

· To select a clip, go to the Browser, to the Logging Bin and simply highlight 1 or more clips 

· Capture Off-Line Clips in Logging Bin – will capture only those clips that have not yet been captured, the ones with the red lines through them.  This is probably the most likely choice.

· Batch Capturing is a very efficient way of capturing… logging is done all at once (more efficient) then capturing is all done automatically

· To Batch Capture you must have continuous time code on your tape or this will not work

· Clip Capture – once a clip has been Logged, you may wish to capture it immediately, if so, hit the Clip capture button. FCP will immediately rewind the deck and capure it.

· done when a break in control track prohibits clip or batch capture, or,

· when you are in a hurry and don’t want to Log first

· or when you are capturing from analog tape such as VHS.

· Not an advisable way of capturing

· Capture Now – captures images “on the fly,” as the tape plays it just grabs the clip (imprecise and done usually as a last resort, or if the tape’s time code is broken)

· The Logging Tab section also contains information about the clip such as the clip name, Reel Number (or Reel Name) and Log Bin
· The clip name is important – pick a short but clear name for your clip, remembering that you may have hundreds of clips in your project.  The clip names should be easily recognized.  Flag Z-in/Wendy’s (zoom in of a flag at Wendy’s restaurant), “JL – I was in Washington” (interview quote from James Leutze)

· ***Each time you start logging or change a tape, make sure to identify the new Reel name/number.  This is absolutely crucial…if your disk crashes or you have other problems during editing and need to recapture your clips, you MUST know which reel the clips are on.  Always make sure your “reel number” (or name) is correct to avoid serious heartache. 
e. Clip Settings

· Capture: Audio and Video together, Audio only, Video Only

· If you know you only need one of the elements, only select the one you need, this saves memory in the computer.

· Audio Format – Stereo, mono, Ch. 1 & 2, or Ch. 1 and Ch. 2
· Generally set this to stereo or mono

f. Capture Settings

· Device Control – Firewire NTSC should be the setting if you are using a DV camcorder in the US.  (Set for Noncontrollable Device if you are capturing from VHS or Hi 8.)

· Capture input – leave set at DV NTSC 48

· Scratch disks – The SCRATCH DISK is where the Video Clips (Quicktime movies captured from your tape) are actually stored on the hard drive.

· Each project will have it’s own Scratch Disk – these will be preset and should automatically set when your group logs on.   

· It is critical that your video files are stored in your exact Scratch Disk account.  

· EVERY TIME you begin editing, double check to make sure the Scratch Disks are set to store YOUR media in YOUR project folder on the hard drive.  This is one of the biggest headaches of editing w/FCP… failure to properly set your SD will cause a multitude of problems, all of them serious.

· Specific techniques will be discussed in class.  However, you must know the basic philosophy of this process.

· When you ‘set your Scratch Disk’ (with the name My Project Media, for example), FCP automatically creates three new subfolders in the “My Project Media” folder – Audio Render, Video Render and Capture Scratch.  Each time you begin to edit you must check to be sure that you set the Scratch Disk to “My Project Media.”  That’s it.  This will automatically put your captured clips into your Capture Scratch folder. 

· About 5 minutes of full-frame video with audio can be stored in 1 gigabyte of computer memory.

· Rendering takes up significant space in some productions so be sure you have enough hard drive space for video clips and rendering.  

5. Beginning to edit with FCP

a. Step 1: Trim each clip

· Double click on the clip you wish to trim.

· That clip will appear in the Viewer Window.

· At the bottom of the clip you will see a time line.  When you hit play, you will see the “play head” (yellow triangle with a line below it) moving along the time line.  This is where you can select the part of the clip you wish to use in the program.

· While the clip is playing hit the IN (I) button to set your IN point, and O to set your OUT point.  

· You may also pause the clip by hitting the space bar.  

· Use the mouse to move the play head back and forth to the exact point you wish to see on the screen

· There are several options for moving and pausing the play head: 

· Spacebar = play/pause

· Mouse allows you to grab and drag the play bar

· Arrow keys move forward one frame at a time

· Control buttons on the Viewer Window also allow control

· The Length of your clip is in a time window in the upper left hand corner of the Viewer.  

· Adjust the clip as needed.  Select only the part of the clip you wish to use in the program by moving the I and O points.
b. Note about the Viewer Window:

· While adjusting the length of your clip, also check out the other clip manipulations you can perform while in the viewer window.  Three extra Tabs at the top of the Viewer enable subtle or extreme manipulation of your clip.

· The Audio Tab – allows manipulation of the audio tracks: frame by frame, volume control, stereo/mono, special effects (accessible through the Effects Tab in the Browser Window).

· The Filters Tab – this tab begins empty.  To add filters you most go to the Effects Tab in the Browser Window.  The Effects Tab is automatically opened when you open the Browser.  Hundreds of filters are available which enable you to manipulate the style of your video.

· The Motion Tab – at a glance, this tab doesn’t seem to offer much.  A closer look reveals that the Motion tab enables you to manipulate the size and location of your clip along with a number of other interesting variables: rotation, opacity, crop, distortion, drop shadow.  This window allows you to manipulate the size, location and motion of your video clip. 

c. Step 2: Drag clip into sequence.  

· Once the clip has been trimmed, place the cursor in the Viewer Window, on top of or next to the clip.

· Hold down the mouse to ‘grab’ the clip.

· Drag the clip into the sequence where you want it, and then let go of the mouse. 

· The video and audio portions of the clip should drop right into place.

· The clip can now be moved and further trimmed if needed.  

d.  Step 3: Move clip in sequence

· Once the clip has been placed in the sequence it can be moved and manipulated in virtually any way imaginable.

6. Final notes about editing in Final Cut Pro

· You don’t get good at editing unless you do it. Practice!  Get your hands on the equipment and you will get better every time you use it.

· Be prepared for a rather steep learning curve.  Digital editing is not easy, so be prepared to get frustrated at times…but don’t let that scare or stop you from moving ahead.

· There are about five ways to do just about everything in Final Cut Pro.  The more you use the system the more comfortable you will become finding YOUR best way of working with it.

· Use the manuals!  That is what they are there for.  Everyone who has learned FCP has spent a great deal of time with the manuals looking for ways of executing edits or effects.

· Don’t be afraid to ‘try things.’ This is how you will grow as an editor. 

· Start by logging your tapes.  Do NOT try to edit while you are viewing the tapes for the first time.

· Create a rough edit of your program before adding specific bells and whistles. 

· Reserve editing time by using the Microsoft Outlook web server

· Log on to Outlook using your student account.

· Locate the Public Files folder.  It will be at the top or left hand side of the page.  Click the plus sign [+] next to the folder.

· Scroll down to the Communication Studies folder. Click the plus sign [+] next to the folder

· Click on the Edit Suites folder.

· Locate the date for which you wish to make a reservation.

· Enter the appropriate information.

· Save and close.

· Edit reservations should be made for no longer than 4 hours.

· If no one has your edit system reserved after you, you may continue working

· Never leave the edit suite door open.

· If you are editing after hours (after the building has closed) you are expected to be working in the edit suite.  Plan ahead so that you do not have to leave the building as you may not be able to reenter. 
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